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New in Version 10
A summary statistics module (SumStats) includes 18 procedures for analyzing counts,
proportions, and means. Sixteen of these procedures are from the StatCalc software package.
The procedures are listed below:
ü Weighted Mean
ü Z-Score
ü Confidence Intervals (Mean/Proportion)
ü Goodness of Fit
ü Chi-Square Test of Independence (6x6 table)
ü Z-Test of Proportions (One/Two Sample)
ü T-Test of Means (One/Two Sample)
ü One-Way ANOVA (6 group means)
ü Z, T, F, Chi-Sq Distributions (estimates p-value)
ü Diagnostic Accuracy (2x2 table)
ü Epi Curve. Creates an Epidemic Curve chart from a timeline with disease onset
counts that can be saved or printed.
ü Disaggregate Counts. Creates a data file from summary statistics for the charts
procedure.
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Introduction
AcaStat provides students, teachers, researchers, and managers with an inexpensive and easy
to use data analysis tool and instructional aid. AcaStat includes a spreadsheet for entering and
viewing data, an Explore module with statistical procedures, an output log, and a summary
statistics module. A statistics glossary is also provided along with example data.

Getting Help
Application help can be found in this manual and in the Help module provided with AcaStat. A
QuickStart guide is also available at http://www.acastat.com/support/support.html.
In addition to application help, statistical help is provided in three formats:
ü Glossary of statistical terms and definitions
ü Student Workbook in pdf format
ü How To Guide for using statistical procedures

Installation
Download an evaluation version or purchase AcaStat from http://www.acastat.com or the Mac
App Store. The software is downloaded in a self-extracting file. Save the software and doubleclick on the file to begin the installation process.

Uninstalling AcaStat
For Mac versions, drag the program file to the Trash Bin. For Windows versions, use the
Windows Control Panel option ADD/REMOVE programs to uninstall AcaStat. Files that were
created or changed after installation of AcaStat must be removed separately by the manual file
deletion procedures in Mac and Windows.

Terminology Used in the Manual
When discussing statistical procedures, the manual will refer to two general types of data -continuous and categorical. The following terms will be used for convenience and simplicity, but
there are variations in these themes that will be apparent to those with statistics training.
Please see the Statistics Glossary in AcaStat for more information on these and related terms.
Continuous Data – This refers to data where it is reasonable to calculate an average. This type
of data is also referred to in statistics as interval/ratio level of measurement or scale data.
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Categorical Data – This refers to data where averages would not be meaningful. This type of
data is also referred to in statistics as nominal/ordinal level of measurement or discrete data.

AcaStat Startup Screen
AcaStat starts by displaying the Explore tab. Use the Explore tab to select and run analyses. A
control panel along the left side of the application contains statistical procedure controls and a
list of variables when a data file has been loaded. The Data tab displays a spreadsheet that can
be used to create or view a data file. The Output Log module automatically displays the results
for the current analysis and stores all analyses conducted after opening AcaStat. The output
from all procedures is automatically appended to the Output Log. The SumStats tab provides
18 summary statistics procedures for counts, proportions, and means.
Startup Default View

When AcaStat becomes sufficiently wide, a placard is displayed along the right side of the
Explore tab. The placard contains file information and a data dictionary for the loaded file that
includes variable labels, value labels, and missing values.
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Explore View When Maximized

Click (>) located to the right of the Procedures List to display the Options Panel.
Options Panel View When Maximized

AcaStat User Manual

9

Explore
The Explore tab contains the statistical procedure options along with a list of variables from the
Data tab. Explore has two display configurations: Explore view (default) or Options Panel.
Users of the prior version of AcaStat will be familiar with the Options Panel view.

Explore View
In the Explore mode, a simplified view of the variable analysis boxes is provided to support
quick analysis of data. The presentation of analysis boxes and charts will vary depending on
the selected statistical procedure. A chart will be displayed if one is available for the selected
statistical procedure. Drag and drop variables into the analysis boxes provided and the analysis
is automatically initiated (no need to click the Calculate button). Variables can also be added to
the analysis by selecting the variable in the Variable list box and then clicking the (+) button by
the analysis box.
Drag and drop another variable to automatically rerun the analysis with the new variable. As
variables are selected for analysis, commonly used summary statistics are presented in the
Explore output display screen for initial review and comparison. A more detailed display of
analysis output is automatically added to the Output Log for saving or printing.
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Options Panel View
Click the (+) button beside the variable list box to open the Options Panel. The Options Panel
displays an option box along with analysis variable list boxes and a control function. Drag and
drop variables into the analysis list boxes and then click the Calculate toolbar button to the run
the procedure. For most procedures, a subset of key summary statistics is presented in the
output display screen for quick review and comparison. As with the default Explore view,
additional summary statistics are added to the Output Log.

Copying and Printing Explore Output
The summary statistics displayed in the Explore tab are temporary and will be lost if AcaStat is
closed or the Reset button is pressed. Although Explore output cannot be saved, the complete
summary statistics produced by each procedure can be saved from the Output Log tab.
Explore output can be printed by clicking the Print toolbar button. The printing format will be
consistent with the Explore display and in most cases is formatted differently than what is
recorded in the Output Log. The output can also be copied and pasted into a spreadsheet or
word processor. To copy all of the visible output, click the copy button without selecting any
rows. To copy only a portion of the output, use the mouse to select the rows for copying.
Pasting the output into a spreadsheet will separate the output into columns so the general
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presentation is not altered. The spreadsheet column widths may need to be adjusted to display
the data properly.

Explore Charts
The display of an Explore chart will depend on the statistical procedure selected. Below is a
summary of the available charts depending on the type of statistical.
Summary of Explore Output and Chart Features
Procedure

*

Explore
Charts
Horizontal bar chart *

Frequencies

Output
Current analysis only

List Variables

List of up to ten variables

None

Descriptives

List of all analyses

Histogram**

Explore Means

List of all analyses

None

Crosstabulation

List of all analyses

None

T-Test of Means

List of all analyses

None

Paired T-Test

List of all analyses

None

Mann-Whitney U

List of all analyses

None

ANOVA

List of all analyses

None

Kruskal-Wallis

List of all analyses

None

Correlation

List of all analyses

Scattergram**

Spearman rho

List of all analyses

None

Point-Biserial

List of all analyses

None

OLS Regression

List of all analyses

Histogram of residuals**

Logistic Regression

List of all analyses

None

Diagnostic Tests

Current analysis only

ROC curve

Sample Random

None

None

Sample Repeated

List of all analyses

Histogram of means**

Appraisal Ratios

List of all analyses

None

Horizontal bar chart is not visible when the Options panel is visible.

** To view a prior chart, select the row containing the summary statistics.
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Chart Print Preview
Click on the chart to open a preview screen. The preview screen allows the user to edit the titles
(click on a title to edit) and change the color of the data points in the chart. Scattergram and line
charts also provide an option to display the numerical values in the graph. All charts can be
printed, saved, or copied for pasting into other software. To increase the size of the chart,
resize the preview form to the desired size.
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Data Module
The Data tab uses a spreadsheet to create, import, and export data files. Opening or importing
a new file will replace the current contents.

Rows
Each row represents one observation (this is also known as the unit of analysis). If the data
contain information on individuals, each row should contain the data for one person
(observation). If the data contain information on cities, each row should contain the data
relevant to one particular city.
Columns
Each column represents data for all observations relating to one variable or characteristic. As
an example, if a column contains information on personal income in U.S. dollars, all data in that
column should represent the income for each person in the data file. For data files with more
than 60 columns, the spreadsheet can be advanced to the next 60 columns by clicking the
forward arrow button.
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Cells
Each cell represents a value for one observation for one variable. It can contain string data
(words) or numerical data (numbers). Most research data files use numerical data to represent
words. As an example, for the variable sex, it is common to code Male as "0" and Female as
"1.” This makes data entry much easier since one number is entered instead of typing a word. It
also simplifies recoding variables, identifying controls, and running analyses.
Entering data
To enter data, point and click on a cell and begin typing. Pressing an arrow key will save the
entry and move the data entry point to another cell. As an example, pressing the right arrow
key will save the entry and move the data entry point to the right. Pressing the Escape (Esc)
key will cancel data entry. Pressing the Enter key will move the data entry point down one row.
Editing data
To edit data, click on the cell to edit. Pressing any of the arrow keys will save the entry and
move the data entry point to an adjacent cell. Do not enter characters such as a
Comma, $, or % and avoid the use of strings (words) whenever possible.
Spreadsheet and Data File Limits
The spreadsheet will display up to 60 columns of data at one time. For data files with more than
60 variables (columns), the spreadsheet can be advanced to the next 60 columns by clicking
the forward arrow button. The number of rows is controlled by system memory and speed of
the computer. Files larger than 100,000 observations will slow loading and analysis.
Large files can be reduced using the Split Data module found in the Data pull-down menu. This
procedure will create a new file with fewer variables. The new file will have the same number of
observations and formatting as the original larger file. Additional variables can be added from
the master file using the Merge Data Files-Add Variables option in the Data pull-down menu. If
a file has a large number of observations, the random sample statistical procedure can be used
to create a more manageable data file.
Lockable Row Identifier
By default, AcaStat numbers each row in a column labeled “Obs”. This simplifies verifying data
for individual records by displaying and freezing a copy of the identifier variable to the left of the
data. If a data file has its own variable (column) with a unique row identifier, select any cell in
this column and click the “+” button at the bottom of the Obs column to display a copy of the
identifier variable to the left of the data. Reset to Obs by clicking the “-“ button.
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Drag and Drop
The data spreadsheet accepts drag and drop for AcaStat data files and delimited text data files
(tab and csv). The Output tab accepts drag and drop for AcaStat output text files.
Formatting Variables
Use the screen displayed to the left of the spreadsheet to format variables. Click a column in
the spreadsheet to view and edit the variable’s formatting. In order to produce output that is
easier to interpret, create variable names and assign short explanatory labels to variable names
and values. Formatting information will be saved with the AcaStat data file and can be changed
at any time. If data are exported, the formatting information will not be exported. Click the Copy
Format button to copy value and missing settings for pasting into other variables with the same
format, such as survey questions with identical response options. Always click “Set” to
record changes to formatting. The data file must be saved as an AcaStat data file to
retain formatting changes.
Variable Name
Since variable names are used as column labels and are listed in the variable list boxes, it is
important to create short but unique variable names (8 characters or less is recommended). As
an example, level of education could be named DEGREE or EDUC or EDYRS.
Variable Label
Use variable labels to create a more detailed description of the variable. The variable label is
used to create more meaningful output. Using the above example, DEGREE could be labeled
"Respondent Highest Degree." Although variable labels can be longer, the Explore output
display works best with variable labels with 30 characters or less
Change Decimals
Reduce the number of decimals displayed (and stored) for the selected variable. This option
will permanently reduce the decimals displayed in a variable when the file is saved.
Value Labels
Use value labels to create a more detailed description of the values used in a categorical
variable. The value label is used to create more meaningful output. If education is coded 0
through 4 to represent five general categories, the values would be more meaningful if labeled
0="< High School", 1="High school", 2="Junior college", 3="Bachelor", 4="Graduate". Without
labels, the output will show the values 0 through 4. Limited to 12 value labels.
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Missing Values
Identify up to four numerical or string values to be excluded from the statistical analysis (blank
cells are always considered missing). Values that are less than (<) or greater than (>) a set
value can also be set as missing.

File Menu
New
Clears all data from the spreadsheet and resets the
variable lists.
Open Data File
Use to open an existing AcaStat data file. AcaStat
data files have the extension ".dcs”. AcaStat files
contain data formatting, coding of missing values,
and data file notes.
Save Data File As
Saves the contents and any formatting of the data into an AcaStat data file.
Data File Information
Displays file information and also has a section for
file notes. Changes to the file notes will not be
retained until the data file is saved.
Import Tab Delimited Data
Opens a text file that contains tabs between each
variable so AcaStat is able to import the data into
a spreadsheet format. These files normally have a
filename extension of ".txt” or ".dat”.
Import Comma Delimited Data
Opens a text file that contains commas between
each variable so AcaStat is able to import the data
into a spreadsheet format. These files normally
have a filename extension of ".csv” (comma
separated values). Countries that use comma
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decimal delimiters should use tab delimited instead of csv to import or export data.
Import Other Delimited Text Data
If uncertain about how the file is delimited, use this option to view the file and identify the correct
delimited character. The correct delimited value will separate the data into columns.
Tips on Importing Data
Import data from text data files or by pasting data copied from a word processor, spreadsheet,
or database table. Please see the section below on using a spreadsheet application to create
compatible data files.
Tips on using a spreadsheet application to create a csv or txt file
The first row in the spreadsheet should contain a unique variable name that represents the data
in that column (try to keep the names 8 characters or less). The variable names identify
columns when imported into the AcaStat spreadsheet and are used to select columns of data
for analysis. To save a delimited text file, use File/Save As and select the file type as either tab
delimited or comma separated values (CSV) format.

Pasting Data
To paste data from a table, select and copy data in a word processor, spreadsheet, or database
table. In the Data module, select "File/Import/Paste Data" or use the paste button on the
toolbar. The paste procedure replaces all data in the current spreadsheet. Copied data must
be consistent with the tips discussed above.
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Importing Text Data Files
AcaStat assumes the first row in an imported file contains the variable names. If the data file is
large, it may take a few moments to read the data. Once read, the data will be displayed in the
spreadsheet and variable names (column headings) will be visible in the variable list box. After
importing data, save the file as an AcaStat system file. This will decrease the time it takes to
load a file and allows the file to retain variable formatting. As noted earlier, use the Split Data
module to reduce the size of very large data files (it is not unusual to see social science data
files with over 800 variables). Additional variables can be added from the master file using the
Merge Data Files-Add Variables option in the Data pull-down menu.
Example of Import Error
When creating a comma separated value file, make sure all commas have been removed from
the cell contents before creating the file. If they are not removed, as might be the case with
currency data, AcaStat’s import procedure will create an extra variable for each comma. This
will cause the cell contents in the AcaStat spreadsheet to be out of alignment with the column.
In the example below, the data in rows two and three do not align properly with the appropriate
columns.

1
2
3

AGE
65
46000

SEX
M
23
45

INCOME
33000
M
F

V4

Other import errors may occur if the text file does not exactly match the format specified above.
The following list is not complete, but it contains common errors in importing data.
•
•
•
•

No variable names in the first row
Blank rows at the top of the data file
Special embedded characters in the cells that are neither numbers nor words. This is
especially common in data copied from an html table from the Internet.
Embedded tabs in spreadsheet cells

Export Data (Tab Delimited)
Use Export Data to save the contents of the spreadsheet as a text file that contains tabs
between each variable (column). These files are given the filename extension ".txt”. This file
can be viewed and edited in word processing or spreadsheet software and can be imported into
other statistical software.
Export Data (Comma Delimited)
Use Export Data to save the contents of the spreadsheet as a text file that contains commas
between each variable (column). These files are given the filename extension ".csv”. This file
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can be viewed and edited in word processing or spreadsheet software and can be imported into
other statistical software.

Edit Menu
Cut
If the Output Log tab is selected, this cuts the selected
text from the output screen.
Copy
If the Explore module is visible, this option will copy the entire output table or only the selected
rows. If the Data module is visible, this operation copies the entire data file for pasting into a
spreadsheet or other software. Copying data does not copy the variable formatting. If the
Output Log tab is selected, this copies the selected text in the output screen.
Paste
When paste is used in the Data module, an import procedure places data copied from another
application into the spreadsheet. Paste clears the spreadsheet before importing the data. The
operation is identical to importing a tab delimited data file. If the Output Log tab is selected, this
pastes the text into the output screen.
Convert Output to Tab Delimited
If the Output Log tab is selected, this formats the output with tabs to improve the alignment of
tables copied from AcaStat for pasting into spreadsheet software. The tabs are used by
spreadsheet software to align the table data properly into columns for further editing and
formatting.
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Data Menu
Hide Format
Hides or displays the format screen.
Add 50 Rows
Adds 50 rows to the bottom of the spreadsheet.
Delete Row
Deletes the row for the currently selected cell. Delete one row or multiple selected rows. The
change will be complete when the data file is saved.
Delete Column
Deletes the column for the currently selected cell. Delete one column at a time. The change
will be complete when the data file is saved.
Copy Data from Spreadsheet
Copies all the data in the spreadsheet for pasting into other software.
Paste Data into Spreadsheet
Paste data copied from a word processor, spreadsheet, or database table. The data must have
variable names on the first row of the copied data. To paste data from a table, select and copy
data in a word processor, spreadsheet, or database table. In Data Grid, select Data/Paste Data
Into Spreadsheet. A data module will display a portion of the data for review before importing.
This procedure replaces all data in the current spreadsheet.
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Split Large Data Files
Use Split Large Data Files to create a new data
file that contains a subset of variables from the
current file. This feature reduces the size of
large data files to increase analysis speed and
improve data editing capacity. The new file
retains variable formatting.
Click the Edit pull-down menu in the Data module
and select the Split Large Data Files option. A
list of the variables in the current data file is
provided. Select variables from the current file
list to include in the new file and click the right
arrow button. To remove a variable from the new
file list, select t he variable and click the left arrow
button. Click run to create the new data file.
Merge Data Files - Add records from another file
This procedure merges two AcaStat data files with matching variable names so that the
observations in one file are added to the observations of another AcaStat data file. The order of
the variables in the matched data files do not have to be identical and the matching of variables
is case insensitive (treats capitalized and non-capitalized letters the same). This procedure is
especially useful if the same data formatting (variable names, labels, value labels, missing
values) is used to collect new data. Examples include repeated surveys or monthly data
downloads from a website or bank account.
Use the following process:
Create and save an AcaStat data file with all the formatting set for variable and value labels and
missing values.
Create additional AcaStat data files by entering the data or importing a delimited data file and
then saving as an AcaStat data file.
To merge files,
1. Open the file that has the formatting
2. Use the menu item [Data/Merge Data Files-Add Records…] to select and open the
second file.
The observations from the second file will be added to the first file. Save this file as an AcaStat
data file and repeat after each file is added. Cells in columns without matching records will be
blank (empty).
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Merge Data Files - Add variables from another file
This procedure adds variables with unique matching record (row) identifiers to link observations
and add variables from another file. The number of rows remains the same but the number of
columns in a data file is increased to add the additional variables. This supports adding
variables from other data collection efforts on the same subjects such as pre-post test
comparisons or cohort studies or adding additional variables from a parent file to a file created
with the Split Data function.
Use the following process:
Verify both files have matching identifying (ID) variables (the ID variable name in both files must
be identical) and the values are unique for each row (no ID number in one data file can be used
more than once). The ID variable is commonly found with variable names such as “ID,”
“IDNUM,” or CaseID.
To merge files,
1. Open one AcaStat data file
2. Use the menu item [Data/Merge Data Files- Add variables…] to select the ID variable
3. Click Set to open the second file.
All of the variables from the second file will be added to the first file. If adding variables from a
master file, use the Split Data option first to create a more defined merge file. Save the merged
file as an AcaStat data file. Cells in rows without matching ID records will be blank (empty).
Create Data Dictionary
This option creates an item in the Output Log of the data file variables, variable and value
labels, and missing values formatting. The data dictionary is displayed in the Output Log for
saving or printing.

Use Weight Variable
Select Use Weight Variable to identify a variable for weighting observations. Weights are used
to compensate for over or under sampling to produce more representative population values
from a random sample. Weights can be used in the frequency and descriptive procedures.
Weights will not be applied to any other procedures. Only one weight can be selected at a time.

Filter Data
Select Filter Data to exclude observations from the analysis. This module can be used to limit
analyses to a finely defined set of observations. Use up to two variables to exclude observations
from subsequent analyses. The rows excluded from the analyses are marked by a bolded X
and shaded. Resetting the filter removes the filter from future analyses. No data are
permanently lost when using a filter.
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A filter variable will be added to the spreadsheet. If the data file is saved after filtering, this filter
variable will be saved and formatted with the filter specifications for later use as a control.

Recode Menu
Recode Variable
Use the values of one variable to create a new variable. This is
most useful when there are several categories in a variable that
can be combined into fewer meaningful groups. As an example,
recoding years of education into less than high school, high
school, some college, and college graduate.

Procedure
ü Select the variable(s) to recode by clicking on the variable name in the list box.
ü Select the operation to perform by clicking on a radio button. For coding less than 12 years
of education, select the "<" button.
ü Enter the value to use as the basis for the recode. For the above example, enter 12.
ü Enter a variable name for the new variable (limit to 8 characters). Example "Edufmt" for
education.
ü Enter the new variable's value to represent the old values. For this example, use 1 to
represent anyone with less than 12 years of education.
ü Click the Recode button.
A new column will be added to the spreadsheet that has the new variable name and the
recoded value. Repeat the process until all values needed for the new variable have been
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recoded. A module is also available to conduct multiple recodes in a single operation (up 100).
Click “Set Multiple Category Ranges,” select a variable, provide a name for the new variable,
and then enter start and end values for each category range. The module automatically
provides default values for the recodes but the values can be edited. Only use numerical data.
More than one variable can be recoded at the same time. Select and recode multiple variables
by holding the Control button [Mac Command button] while selecting variables in the list box.
Leave the variable name blank. AcaStat will automatically name each new variable using the
original variable name and adding "-2" to the name. This option should only be used if the
variables have the same range of potential values (e.g.; 1 to 10; 1,2,3,4; etc.).
Compute New Variable
Create a new variable by mathematically manipulating the values of the original variable. This
is most useful when transforming a variable such as by squaring (^2) or taking the square root
(^.5) of the original values. It is also useful for applying a constant to all observations in a
variable to remove negative numbers or to develop an index. The Compute procedure can be
used to create an exact duplicate of a variable, a new variable that represents the natural log of
a variable’s values, a mean centered variable, or a variable converted to standardized (Z)
scores.

Procedure
ü Select the variable to use for the compute from the list box.
ü Enter a variable name for the new variable (limit to 8 characters). Example "AgeSq" for
squaring age in years.
ü Select the operation to perform by clicking on a radio button.
ü Enter the value to use in the compute statement. Note that ^2=square and ^.5=square root.
ü Click the Compute button.

AcaStat User Manual

25

A new column will be added to the spreadsheet with the variable name and the computed
values for all observations. Select and compute multiple variables by holding the Control button
[Mac Command button] while selecting variables in the list box. Leave the variable name blank.
AcaStat will automatically name each new variable using the original variable name and adding
“-2” to the name.
Combine Variables
Use Combine Variables to create a third variable that is a mathematical combination of two
other variables. This feature creates a new variable that contains the result of the computation.
Repeat the operation to systematically combine several variables into one.

Procedure
ü
ü
ü
ü
ü

Select the first variable to use from the list box and click the Var1 button.
Select the second variable from the list box and click the Var2 button.
Enter a variable name for the new variable (limit to 8 characters).
Select the operation to perform by clicking a radio button.
Click the Combine button.

Find and Replace Values
Use Find and Replace Values to change cell contents within one or more variables. This
feature is most useful for correcting data entry errors or changing string contents to values (e.g.,
to change “Male” and “Female” strings so that all “Male” strings are coded the value 0 and all
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“Female” strings are coded the value 1). Use Undo to return the cell contents to the immediate
preceding value.
This procedure can be used on one or multiple variables by holding the Control button [Mac
Command button] while selecting variables.
Procedure
ü
ü
ü
ü

Select the variable to search by clicking on the variable name in the list box
Enter the value or string of the search parameter
Enter the value to use to replace the search parameter
Click the "Replace" button

Note: It may be helpful to create and use a duplicate variable before conducting replace
operations so the original variable is not disturbed. Use the Compute procedure to duplicate a
variable. After ensuring the computed variable is accurate, the original variable may be deleted
by selecting the variable in the data spreadsheet and deleting that column.
Trim Values
Use Trim to create a variable that contains a truncated version of the original values. As an
example, banking data may present activity with common leading text followed by unique date
or transaction numbers. For this example, trimming the left most characters will condense data
into common values so aggregate measures can be calculated by type of transaction.
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Procedure
ü Select the variable trim by clicking on the variable name in the list box
ü Select the location of the trimming as either starting from the left, starting from the far right or
a range in between.
ü Enter the number of characters to include in the trimming operation
ü Click the "Trim" button

Calculate Menu
Run Procedure
Select Run Procedure to start an analysis. This has the same function as the Calculate button
on the toolbar.
Run Chart
Select Run Chart to create a chart. This has the same function as the Calculate button on the
toolbar.

Data Examples Menu
Use the example files to view variable and value
formatting and to practice using statistical procedures
and the Output Log. The Student Workbook data file is
a good practice file for experimenting with the statistical
procedures and becoming comfortable with the Explore,
Data, and Output Log tabs. Use the Diagnostic Tests
data file to try the Diagnostic Accuracy procedure. Use
the Appraisal Ratios data file to try the Appraisal module.
Additional data files and codebooks are available at
http://www.acastat.com/data/data.html.
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Documentation Menu
AcaStat includes links via an Internet connection to a
QuickStart guide, a User Manual, a Student Workbook,
and a How To Guide in pdf format. To read these files,
Adobe Acrobat Reader version 6.0 or later must be
installed on the host computer. Acrobat Reader is a free
download from Adobe. For more information, visit
http://www.adobe.com for download information. Internet
access is required to view the documentation.
QuickStart
This is a one-page overview of AcaStat that will help orient first time users.
File Name: QuickStart.pdf
Availability: Website http://www.acastat.com/support/support.html
Student Workbook
The Student Workbook contains over 20 lessons designed to introduce basic statistical
concepts while also demonstrating the functionality of AcaStat. The Appendix includes
instructions for using SPSS.
The Student Workbook can be opened via the AcaStat Documentation menu.
File Name: Workbook.pdf
Availability: Website http://www.acastat.com/support/support.html
How To Guide
This provides a pdf version of the complete How To Guide that is accessed by clicking the “How
To” toolbar button.
File Name: HowToGuide.pdf
Availability: Website http://www.acastat.com/support/support.html
Purchase Applied Statistics iBook
The Applied Statistics iBook contains formulas, definitions, and examples along with annotated
output from statistical software. It is designed to be a quick reference resource (not a complete
statistics text). The iBook is available for purchase from Apple or as a pdf from acastat.com.
Availability: Website http://acastat.com/statbook/statbook.html
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Statistical Procedures Control Panel
The Statistical Procedures control panel is used to select the type of analysis and variables.
When the Options Panel is visible, an options box is displayed for each procedure and analysis
list boxes are available.

Controls
Variable List
Use the Variable List to select the variables for analysis.
As an example, to produce frequencies tables for the
variables sex and race, select the sex variable in the
variable list box. A [+] indicator will appear in the
Analyze header. To add the selected variable to the
Analysis Variables list box, click the list box header or
drag the variable to the Analyze list box. Use the same
procedure to select and place the race variable in the
list box. Clicking the Calculate toolbar button will
produce frequencies for both variables. Output from the
analyses will be displayed automatically and added to
the Output Log.
Dependent Variable
The topmost variable list box is used for all univariate
analyses (Frequencies and Descriptives) and one
bivariate analysis (Correlation). At least one analysis or
dependent variable must be placed into the Analyze list box.
Independent Variable
With the exception of Frequencies, Descriptives, and Correlation procedures, an independent
variable must also be selected (another list box will appear below the Analyze list box). In the
case of t-tests, subgroup values may be set in the options box for the independent variable so
AcaStat compares the correct groups; or, when left blank, a t-test comparison is conducted on
all possible group comparisons.
Control Variable
A control can be established for all procedures. This limits the analysis to a specific subgroup.
As an example, to correlate income with education for females only, locate the Sex variable
name from the variable list box and drag it into the control box, click the "=" button and indicate
the value used for females. This would result in a correlation procedure that excludes all males.
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The control should be a value (number) not a string (character). If using a string control, only
use the “=” control operator.
Tips for using the Control Box
If the “All Categories” option is available and selected, AcaStat will product statistics for each
category in the control variable. Some procedures will not allow or display the “All Categories”
option. In this case, the specific control value must be set. The All Categories feature is handy
for categorical controls such as sex and race but is not recommend for continuous controls such
as age, body weight, and income unless they are first recoded into fewer groups as categorical
values.

Statistical Procedures
One of the statistical procedures must be selected to run an analysis.
Frequencies
This produces a listing of all the values in a variable, the number of times the values occur in the
variable, and the percent of cases represented by each value. Frequencies can be produced on
numerical and string data.
List Variables
This produces a listing of observations for up to ten variables. Observations are listed in the
order they appear in the data file.
Descriptives
Calculates measures of central tendency (mean, median) and variation (variance, standard
deviation).
Explore Means
Explore Means produces descriptive statistics (sum, count,
mean, sample standard deviation, standard error, 95%
confidence interval) for each subgroup in the selected
categorical variable(s). Explore requires continuous data for
the analysis variable. The categorical variable can be a
numeric or string variable.
Explore “Options” limits the output to selected summary
statistics. This is very useful when using a categorical “By”
variable. An example of a "limited" version of output is
provided below.
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Explore Means
EDUC

by WRKSTAT

WRKSTAT
Count
Mean
Median
-------------------------------------------------------------Full-time
915
14.0984
14.0000
Part-time
234
13.5726
13.0000
Temp not working
33
13.8182
13.0000
Unemployed
143
12.6224
12.0000
Retired
319
13.0721
12.0000
School
93
13.9032
14.0000
Keeping House
234
12.1581
12.0000
Other
65
11.7846
12.0000

Crosstabulation
This is a useful procedure for representing the association
between two categorical variables in a contingency table. Each
cell in a contingency table represents a subgroup. For each
cell, the count, row percent, column percent, and total percent
are reported (default). This procedure also automatically
produces a chi-square statistic. Crosstabulations are easiest to
interpret when the number of rows and columns in the
contingency table are 5 or less.
Crosstabulation “Options” limits the cell contents of the output.
An example of the output when cell contents are limited to
count and column percent is provided below. Limiting cell
contents does not affect the display of statistics in the Explore
tab but it does alter what is presented in the Output Log.
Column Variable Label: Respondent Sex
Row Variable Label: Race of Respondent
Count |
Col % |Male
|Female
|
Total
--------------------------------------------White
|
689|
861|
1550
|
77.33|
74.67|
--------------------------------------------Black
|
118|
193|
311
|
13.24|
16.74|
--------------------------------------------Other
|
84|
99|
183
|
9.43|
8.59|
--------------------------------------------|
891|
1153|
2044
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T-tests of means
Compare the difference between two sample means. For t-tests, the dependent variable must
be a continuous variable to produce the means for analysis. The independent variable must be
a categorical variable (often it will be a dichotomous variable such as sex: 0=male, 1=female).
Values representing the comparison groups for the independent variable can be set in the
option frame. These values are used to separate the dependent variable into two groups. Be
careful to use the correct values or there may be an error reported that indicates there are not
enough cases to compute the t-test. If there are more than two values in the independent
variable, the other subgroups will be excluded from the analysis. If the group values are left
blank, a t-test comparison is conducted on all possible group comparisons.
Paired t-test
Evaluates the significance of the mean difference between matched pairs (e.g., a pre-post
experimental study design). Paired t-test requires numerical data. Select the variable(s) in the
variable list box and drag one variable to the Sample A list box and one paired variable to the
Sample B list box. You can select multiple variables by holding the Control button [Command
button on Macs] and clicking variables in the list box.
Mann-Whitney U
Mann-Whitney U is a nonparametric test that evaluates the significance of the difference
between two distributions of ordinal samples. This procedure is similar to the two-sample t-test
but it does not require the assumption of continuous data in the dependent variable. It requires
numerical data in the ordinal list box. Select the variable(s) in the variable list box and drag the
ordinal variable to the Ordinal list box and one categorical variable to the Categorical list box.
Select multiple variables by holding the Control button [Command button on Macs] and clicking
variables in the list box.
Analysis of Variance (ANOVA)
Compare the difference between two or more sample means. Like t-tests, the dependent
variable must be a continuous variable to produce the means for analysis. The independent
variable must be a nominal level variable (e.g., race: 1=white, 2=black, 3=Asian, 4=Hispanic. or
ordinal (e.g., political ideology: 1=conservative, 2= moderate, 3=liberal). ANOVA optional
output includes summary statistics for each subgroup and the Bonferroni post hoc test for
multiple comparisons.
Kruskal-Wallis
Kruskal-Wallis is a nonparametric test that evaluates the significance of differences between the
distributions of two or more samples. This procedure is similar to one-way ANOVA but it does
not require the assumption of continuous data in the dependent variable. It requires numerical
data in the ordinal list box. Select the variable(s) in the variable list box and drag the ordinal
variable to the Ordinal list box and one categorical variable to the Categorical list box. Select
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multiple variables by holding the Control button [Command button on Macs] and clicking
variables in the list box.
Pearson Correlation
Calculates the Pearson correlation coefficient to represent the association between two
continuous variables. There are two options: create matrix or a scatterplot. The scatterplot
option provides basic statistics and displays a visual representation of the association between
two variables. For multiple comparisons, a correlation matrix is often the best choice.
Spearman rho
Evaluates the linear association between two ordinal variables. This procedure is similar to
Pearson Correlation but it does not require the assumption of continuous data in both variables.
It requires ordinal numerical data. Select the variable(s) in the variable list box and drag the
ordinal variables to the Analyze list box. Select multiple variables by holding the Control button
[Command button on Macs] and clicking variables in the list box.
Point-Biserial Correlation
Evaluates association between one continuous variable and one dichotomous variable. This
procedure provides results equivalent to Pearson Correlation but it includes additional options
for descriptive statistics and a test for homogeneity of variance. It requires numerical data in the
Continuous list box. Select the variable(s) in the variable list box and drag the continuous
variable to the Continuous list box and one categorical dichotomous variable to the Categorical
list box. Select multiple variables by holding the Control button [Command button on Macs] and
clicking variables in the list box.
OLS Regression
Calculates simple regression (one independent variable) or multiple regression (two or more
independent variables). Ordinary least squares (OLS) regression requires a continuous
dependent variable. As an option, ordinary least squares regression will add new variables to
the spreadsheet representing residuals or predicted values for each observation. OLS also
allows models with no constant (regression through the origin). Summary statistics for the
variables included in the model are automatically included in the output.
Logistic Regression
Logistic regression requires a dichotomous (two values) dependent variable. The two values
in the dependent variable must be “0” and “1”. Logistic regression will automatically
produce summary statistics and, as an option, will add a new variable to the spreadsheet
representing the predicted values for each observation.
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Diagnostic Accuracy
Diagnostic accuracy compares a test result to a dichotomous reference standard. It is used to
evaluate the sensitivity and specificity of a diagnostic test. The reference variable can only be
two values (usually 0 for non-disease and 1 for disease). This represents the gold standard to
compare to the test results.
Each cell in the table holds counts. The test variable can be nominal, ordinal, or interval/ratio.
The lowest value for the reference standard must always represent non-disease. The cutpoint
(T+ >) represents the point beyond which the test is positive (disease indicated).
As an example, if possible test results range from 1 to 4, a cutpoint of 1 means a negative test
result and a positive test is indicated by a value of 2, 3, or 4. A practice data file “Diagnostic
Tests” is included with AcaStat. The data represent the use of Power Doppler imaging to
estimate the level of a patient’s carotid stenosis (blockage of the carotid artery).
Simulation
Two simulation procedures can be used for manipulating data in the spreadsheet. They are
designed to help students develop a better understanding of random sampling. The Random
Sample option creates a random sample from a larger data file. Assuming the larger data file
represents the entire population, a smaller random sample helps students discover how
summary sample measures such as means and proportions will vary from population
parameters.
The Repeated Sampling procedure conducts multiple random samples on one continuous
variable to build a data set that reflects summary measures of that variable for each random
sample. This procedure helps students test the Central Limit Theorem:
Central Limit Theorem
As sample size increases, the sampling distribution of means approximates a
normal distribution and is close to normal at a sample size of 30.
Random Sample
This procedure is used to create a data file that is a
randomly selected subset of the current spreadsheet.
Enter the sample size desired. The sample size must
be less than the total number of observations in the
current data file. Click the Run button to replace the
current data with a random sample.
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Repeated Sampling
This procedure creates repeated random samples for
one continuous variable in the current spreadsheet. For
each sample (iteration), the mean and standard
deviation are computed and placed into the
spreadsheet. This results in a new data file where each
row represents the summary statistics for one random
sample.
Enter the size of the samples (n) and the number of
random samples (Iterations) desired. Select a
continuous variable to conduct the random sampling on
and place it in the list box. Only one continuous variable
will be used for the random sampling. Please note that
the sample size must be less than the total number of
observations in the current data. Click the Run button to
replace the current data with a sampling distribution.
When the sampling is complete, AcaStat will run the
Descriptives procedure on the mean variable.
Appraisal Ratios Procedure
The Appraisal Ratios procedure is used to evaluate tax assessment values of real estate. Use
of this procedure requires data on the market (selling) price and the assessed value of homes to
compute ratios and other statistics. A practice data file “Appraisal Ratios” is included with
AcaStat.
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Charts Module
When in the Explore tab, click the chart toolbar icon to open or close the Charts module. The
Charts module produces graphic displays of data. The chart can be saved, printed, and copied
by using the toolbar buttons or menu pull-down. The chart can also be formatted to adjust
background, titles, and decimals. A control variable can be used to chart subgroups of data.

Save Chart
If using Windows and the system does not have QuickTime installed, the chart is saved as a
".bmp" file. Enter a file name and add the extension “.bmp” to ensure the file is saved as an
image file. For Mac systems and Windows with QuickTime, other file type options are available
such as gif, png, and jpg.

Paste Chart
If using Windows, use Paste Special/Bitmap to paste the chart into other software such as
Microsoft Word. Mac users will only need to use Paste to insert the chart into a document.
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Variable Limits
Some charts only use one variable (e.g., column and pie charts), while others use two variables
(scatterplot).

Editing Charts
Most features of the charts are automatic based on the data and the labeling of variables and
values in the data file. However, some settings can be changed by clicking the Edit Chart
button to view chart options. Options include changing the chart title, axis labels, and the chart
background. Decimal values and minimum and maximum values for the Y and X axis (currently
only available for scatterplots) can also be changed. Click OK to rebuild the chart using the new
settings. Click Cancel to close without making the changes. The chart procedure will return to
the default settings when a new chart is created.

Using the “By” Variable List box
To produce a chart with group comparisons, place the grouping variable in the “By” variable list
box. An example is shown below where marital status in analyzed by the sex of the respondent.
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Print Preview
To open Print Preview, click the Print Preview button or click on the chart. Print Preview
provides options to save, copy, and print the displayed chart. Enlarge the chart image by
clicking the Maximize button (full screen view) or manually resizing the form. This option is
especially helpful for improving the display of charts where the X axis labels are crowded.
Clicking the Maximize button again will restore the previous image size.
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Output Log
The Output Log tab displays the results of the analysis in a text window for editing, printing, and
saving as a text file. Each time a statistical procedure is run, the results are automatically sent
to the output log. Notes can be added to the output before printing or saving.
The Output Log uses Courier font. This is a fixed font that ensures proper alignment of the
tables. When copying output to a word processor, the default font may not be Courier in the
word processor. This will result in tables that are out of alignment. To correct this, highlight the
output in the word processor and change the font to Courier. The font size may also need to be
reduced to ensure the output fits widthwise on one page.

AcaStat User Manual

40

File Menu
New
Click the "New" button to erase all output.
Open Output File
This feature will load output saved from AcaStat Software
statistical software products (AcaStat and StatCalc).
Save Output As
This menu item saves output as a text file with the file extension ".txt”. This file can be opened
in any word processor or spreadsheet application. Save all output or selected items in the
output log. To select multiple items in the Mac version, press and hold the Command key while
selecting items in the output log. For the Windows version, use the Control key for the same
function.
Print Output
This menu item prints all output or selected items in the output log. To select multiple items in
the Mac version, press and hold the Command key while selecting items in the output log. For
the Windows version, use the Control key for the same function. By default, AcaStat prints a
date and time header and a Notes section on each page printed.

Edit Menu
Cut
Use this menu item to remove selected output text and
save the text to the system clipboard.
Copy
Use this menu item to copy selected output text to the system clipboard.
Paste
Use this menu item to paste text from the system clipboard into the output screen.
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Select All
Selects all the text in the output screen.
Convert Output to Tab Delimited
Use this option to convert output to improve copying and pasting tables into a spreadsheet.
This option inserts tabs into the output so that pasted output aligns properly in the columns of a
spreadsheet.
Use the Edit menu item Convert Output to Tab Delimited to convert the text. The operation will
automatically select the converted text. Click the copy button and open a spreadsheet program,
select a cell in the spreadsheet, and click the paste button in the spreadsheet. Check the
results carefully to ensure the table is formatted and aligned properly.
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SumStats Module
The SumStats tab provides 18 procedures for analyzing counts, proportions, and means.
Sixteen of these procedures are from the StatCalc software package. The output for each
procedure is appended to the Output Log. Some output has additional statistics in the Output
Log than is displayed in the SumStats tab.

Statistical Procedures
Weighted Mean
Calculates the mean for a group of means. For each mean, enter the mean and its sample size.
Click calculate when done. The output includes the mean if the group of means had not been
weighted by the sample size. This value is for comparison purposes only. Do not use the
unweighted mean.
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Z-Score
Calculates the standardized score for a specific value in a distribution represented by a mean
and standard deviation.

Confidence Interval for the Mean
Calculates the confidence interval for the population mean based on a sample mean, standard
deviation, and given sample size. The confidence level is adjustable from 80% to 99%.
Confidence Interval for the Proportion
Calculates the confidence interval for the population proportion based on a sample proportion
and given sample size. The confidence level is adjustable from 80% to 99%.

Diagnostic Accuracy
Diagnostic accuracy compares a test result to a dichotomous reference standard. It is used to
evaluate the sensitivity and specificity of a diagnostic test. The reference and test variables can
only be two values (usually 0 for non-disease and 1 for disease). The reference variable
represents the gold standard to compare to the test results.
Goodness of Fit
Use this procedure to evaluate the variation in a distribution of categories. Each row in the table
represents one category among several. For each category, enter the observed count and the
expected count. Generally the expected count is established by estimating a priori the
proportional distribution of the categories. The expected frequency for each category can be
obtained by multiplying the total observed sample size by the a priori (expected) proportion for
each category. StatCalc calculates the standardized residual for each category. A residual of
+/- 2.0 or greater suggests that category had a substantive impact on the chi-square test
statistic.

Chi-Square
This procedure presents the association between two categorical variables via a contingency
table. Each cell in a contingency table represents a subgroup. All the rows and columns
provided by StatCalc do not need to be used but always start with the top leftmost cell. Enter
counts in each cell and StatCalc will calculate for each cell the row percent, column percent,
and total percent.
This procedure also automatically produces several contingency table statistics to include the
chi-square statistic and measures of strength of association. StatCalc chi-square allows for a
contingency table with up to six rows and six columns.
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Z-test One Sample
Used to test for the difference between one population proportion and one sample proportion.
Enter the population proportion, sample proportion, and the number of observations in the
sample.
Z-test Two Sample
Used to test for the difference between two sample proportions. For two sample z-tests, both
dependent and independent variables must be nominal level variables.
T-test One Sample
Used to test for the difference between one population mean (mu) and one sample mean. Enter
the population mean, sample mean, sample (or population) standard deviation and the number
of observations in the sample.
T-test Two Sample
Used to test for the difference between two sample means. For t-tests, the dependent variable
must be an interval/ratio level variable to produce the means for analysis. The independent
variable must be a nominal or ordinal level variable (often it will be a dichotomous variable such
as sex: 1=male, 2=female).
One-Way ANOVA
Used to test for the difference between two or more sample means. The dependent variable
must be an interval/ratio level variable to produce the means for analysis. The independent
variable must be a nominal level variable (e.g., race: 1=white, 2=black, 3=Asian, 4=Hispanic) or
ordinal (e.g., political ideology: 1=conservative, 2= moderate, 3=liberal). All the rows and
columns provided do not have to be used but always start with the top leftmost cell. StatCalc
ANOVA allows for up to six categories of sample means.
Z Distribution
Enter a z score to calculate the proportion of the probability distribution at or beyond the score
entered. This procedure is most useful for evaluating the statistical significance of a z-test
statistic calculated manually.
T Distribution
Enter a t score and degrees of freedom to calculate the proportion of the probability distribution
at or beyond the score entered. This procedure is most useful for evaluating the statistical
significance of a t-test statistic calculated manually.

AcaStat User Manual

45

F Distribution
Enter a f ratio score and numerator and denominator degrees of freedom (consult a statistical
reference) to calculate the proportion of the probability distribution at or above the score
entered. This procedure is most useful for evaluating the statistical significance of an f test
statistic calculated manually.
Chi Square Distribution
Enter a chi-square score and degrees of freedom to calculate the proportion of the probability
distribution at or above the score entered. This procedure is most useful for evaluating the
statistical significance of a chi-square test statistic calculated manually.
Epi Curve
Enter time and case data to create an Epidemic Curve. The time column data must include
consecutive dates even if there are no cases for that date. Data entry can be copied and
pasted into spreadsheet or document software for saving and later pasting back into the
Epidemic Curve procedure.
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Click on the chart to enter Chart Preview. Click show data values to display counts in the chart
columns. Click on the main chart body and a pop-up color picker will be displayed to change
the color of the data values displayed in the columns.

Disaggregate Counts
Enter category headings and count data from summary statistics to create a case level data file
in the AcaStat Data tab for analysis and creating charts. Data entry can be copied and pasted to
and from spreadsheet or document software.
To view how data needs to be formatted for pasting into SumStats, copy the example data and
paste it into a spreadsheet. The example data should appear similar to the following:
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Other Menu Items and AcaStat Features
Help Menu
AcaStat Help
Click Help to open the help module. The contents can
be sorted or searched by topic.
Statistics Glossary
The glossary contains over 200 terms and definitions. The search button will find matching
records and sort the list box so all topics matching the search are listed at the top in bold.
Pressing the Enter key after entering a search term will also initiate the search. Press Reset
before conducting another search.
Support Webpage
This links to the AcaStat support web page.
Check for Updates
The Help menu contains an option to check for updates. AcaStat connects to the Internet and
automatically compares the installed version with the version of the update. If a newer update is
available, the appropriate installation file may be downloaded to the computer desktop.
The update option is only available for licensed users. It is not available for versions purchase
from Mac App Store. Updates for Mac App Store purchases are automatically pushed to
licensed users.

System Requirements
Mac OS X 10.7 or later
Windows Vista or later
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AcaStat Software
http://www.acastat.com
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